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What is Covered in This Document 

•  This document describes using Orbit to support your Inter-Company Balance Sheet Hedging program.  The discussion 
includes: 

–  An overview of Balance Sheet Hedging using Orbit (page 3) 
–  Treasury setup.  Including setup of IC Relationships and Worksheet Assignment  (page 5) 
–  Field setup of anticipated IC Relationships and confirmation of that setup by Treasury (page 20) 
–  Publication of forecast data entry forms (page 29) 
–  Viewing and editing an Exposure Forecast Data Entry form (page 36) 

•  Lock Exposure Forecast Columns to Prevent Further Entry (page 41) 
–  Creating Mid-month and Month-End payment requests using the OrbitHF Application (page 45) 
–  Treasury processing of payment requests (page 50) 
–  Use the IC Balance Sheet Trade Worksheet to view and hedge consolidated exposures (page 58) 

•  Re-Hedge (hedge tune-up trades) 
•  Current Position 
•  Hedge Day, generating trades, uploading to a trading portal 

2 



Overview 

Orbit provides a number of specialized features aimed at supporting FX Inter-company Balance Sheet Hedging.  These tools 
and features make the following assumptions: 

- There are many companies and subsidiaries (Orbit calls these Entities)  in the enterprise who operate with different 
accounting currencies 
- These Entities transact with each other which creates accounting exposures on the balance sheet (inter-company payables 
and receivables) to different entities/currencies 
- Treasury is responsible for hedging these exposures between Entities  (as well as exposures with external counter-parties) 
- The Hedging program operates month to month in an ongoing cycle 

The Orbit Balance Sheet Hedging program provides screens and processes to perform the following tasks: 

1) Treasury sets up Entities in Orbit where each Entity is identified by a Short Name and the Entity’s accounting currency.  
Other pieces of Entity information may also be stored, such as: GL Number,  additional coding used by your ERP or other 
systems (eg. Hyperion code) 
2) Treasury works with Orbit support to define the format for a Exposure Forecast Data Entry Worksheet.  Orbit support 
updates table in Orbit so that it can generate a data entry screen that follows that format 
3) Treasury defines an initial set of Inter-Company Relationships. Treasury may customize rows included on the Forecast 
Data Entry Worksheet for each IC Relationship.  Additional coding my also be included for the relationship using “Custom 
Properties” 
4) Treasury sets up remote users with Orbit userID’s and passwords.  Treasury assigns each user with access to particular 
Exposure Forecast Data Entry forms.   
5) Remote users download and install the OrbitHF application.  Treasury provides them with login credentials.  OrbitHF users 
login to Orbit and are prompted to change their initial passwords 
6) Non-Treasury users in the field, using the OrbitHF application, may initiate the setup of new exposure relationships.  
Treasury will receive notification of these requests.  The new relationships become active after Treasury review and approval 
7) Each month Treasury “publishes” Exposure Forecast Data Entry forms for all “active” exposure relationships that are setup 
in Orbit 3 



Overview 

8)  Treasury may use Orbit to generate email notifications to remote users letting them know that exposure forecast forms 
are ready for entry 

9)  OrbitHF users update the Exposure Forecast they are responsible for 
10) OrbitHF users enter mid-month and month-end inter-company payment requests 
11) Treasury is notified when payment requests are made.  Treasury uses Orbit to review payment requests and approve or 

deny.  Orbit generates an FX Swap trade for approved payment requests and also updates Exposure Forecast forms to 
reflect the scheduled payment.  The purpose of the swap is to purchase the currency required for the payment and to 
update the outstanding hedge position 

12) Trade intentions created in Orbit are uploaded to the FX Trading portal for execution.  After execution, results are 
download from the portal back into Orbit and trades are marked as executed and/or confirmed 

13) After entry of the initial forecast for the new period, Treasury uses the “FX I/C Balance Sheet hedge Worksheet” to 
compute and generate “tune up” trades to adjust the outstanding hedge position from the previous month 

14) When the current period hedge trading day arrives, Treasury uses the “FX I/C Balance Sheet hedge Worksheet” to 
generate trade intentions needed to close out the expiring hedges from the previous month and to put on new hedges to 
the end of the next month 
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Orbit Administration and Setup 
Entities 

Exposure Relationships 
Remote User Setup 

Exposure Forecast Data Entry Form Assignment 
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Orbit Administration and Setup 

•  The next several pages describe the tasks Treasury performs setting up Orbit to support the Balance Sheet Hedging 
program 

– Setup Entities (page 7) 
– Setup of exposure data entry relationships and forms (page 12) 
– Approve new relationships requested by remote users through OrbitHF (page 20) 
– Setup of Orbit OrbitHF and Web Portal users (page 24) 
– Assign Web Portal Users access to data entry forms they will be responsible for (page 26) 
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Orbit Administration and Setup – Setup Entities 

•  Entities represent companies, subsidiaries and non-bank external counter parties that are relevant to Treasury 
•  To setup a new Entity: 

–  Go to the “Cash” tab of the “Main Menu Window” (You can always get to the Main Menu Window by selecting 
“Main Window” from the “File” menu 

–  Click the “Setup Entities” button  

7 



Orbit Administration and Setup – Setup Entities 

•  Existing Entities are listed one Entity per line 
•  The Entities which are displayed may be filtered by clicking on rows in the “Regions” and “Business Units” lists located 

on the left side of the window 
•  To view the details of an entity, click on the disclosure control next to the Entity Short Name.  All of the fields defined for 

the Entity are displayed below the selected Entity line 
•  Some fields may have different labels in your installation.  For example “TaxID” may be relabeled as “Hyperion Code” 

depending on your particular needs 
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Orbit Administration and Setup – Setup Entities 

•  To create a new Entity, click the “New” button 
•  A blank line is added to the top of the list with it’s detail “expanded” 
•  Enter values for the Entity by clicking into the “Short Name” field and typing 
•  When you press RETURN or TAB, the data entry focus moves to the next field 
•  Some fields, such as currency,  will drop down a selection list when the field get focus.  You will then select a value from 

the drop-down list by clicking or using the up/down arrow keys to navigate through the list 
•  These values should always be provided:  Short Name, Full Name, Company Number (the Entities GL number), 

Currency (the GL reporting currency of the Entity) and Country 
•  After entering Entity values, be sure to click the “Save” button.  If you enter or change multiple Entities, all changes and 

additions will be save when you click the “Save” button 
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Orbit Administration and Setup – Setup Entities 

•  If an Entity will be an “Accounting Entity” for FX exposure purposes, you may want to also make it a “Trading Entity” so 
that it can trade to hedge it’s exposures.  This is not required if the “Limit FX to Exposure Collection Only” preference is 
set on the “FX” tab of the “Preferences” window.  Only use this option if you are not using Orbit for hedging 

•  If an Entity will be an “Accounting Entity”, another Entity can trade on it’s behalf as long as that other Entity shares the 
same GL reporting currency as the “Accounting Entity” 

•  Entities may be setup as Trading Entities in Orbit but when the trade is uploaded to the trading portal the trade may 
appear to be in the name of some other entity.  This is controlled by the setup on the FX Trading Portal window (see the 
next page) 
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Orbit Administration and Setup – Setup Entities 

•  Go to the “FX Trading Portal Interface” window (Main Menu Window -> FX (tab) -> FX Trading Portals (button) 
•  Click the “Edit Portal Settings” button 
•  Orbit pops up the “Portal Setup” dialog.  Go to the “Fund ID’s” tab 
•  The values in the left hand column are the entity values that will be sent to the portal.  The values in the right hand 

column are the Orbit trading entity identifiers 
•  This mapping allows for Orbit to records trades with individual entities, while trading at the portal in the name of a 

different entity 

11 

Edit Portal 
Setting 

Values the 
Portal  
sees 

Orbit 
Trading 
Entities 

Be sure 
and SAVE 



Orbit Administration and Setup 

Setup Exposure Relationships 
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Setup Exposure Data Entry Relationships and Forms 

•  Orbit requires you to specify every exposure relationship you will be collecting data for 
•  An “Exposure Relationship” is composed of an “Accounting Entity” and a Exposure Counter Party,  which is a currency 

and/or Entity 
•  An “Accounting Entity” is an Orbit Entity that you setup on the “Entities” window (see discussion beginning on page 6).  

It is referred to as an Accounting Entity because the General Ledger of that entity is impacted by transactions with other 
counter parties that are denominated in currencies which are different from the Accounting Entitiy’s GL reporting 
currency 

•  Exposure Counter Parties may be other enterprise companies/subsidiaries or they may be currencies associated with 
the special Orbit Entity named “External” 

•  The next several pages describe how to create Exposure Relationships 

•  From the “Main Menu Window”, go to the “FX” tab 
•  Click the “Enter Balance Sheet Forecast” button 

•  When you click this button, Orbit opens the “FX Setup Balance Sheet Forecast Worksheets” window.  Note that if you 
have many relationships, it can take a few seconds for Orbit to prepare and open the window 
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Setup Exposure Relationships 

•  Go to the “Worksheet Setup” tab 
•  If you are adding a new exposure currency to an already existing Accounting Entity, select the Accounting Entity from 

the drop-down menu.  Note: Each line in the drop-down shows an “Accounting Entity” and it’s “Trading Entity”.  In the 
usual case, the Accounting and Trading entities are the same, so you see the Entity Short Name repeated twice 

•  When you select a Accounting/Trading entity from the drop down, Orbit displays the Accounting Entity’s exposures (see 
page 15) 

•  If you are setting up a new Accounting Entity, click on the “New” button and then the  “Accounting Entity” button (circled 
in red) 

•  When you click on the “Accounting Entity” button, an Entity selection list dialog will popup.  Select the Accounting Entity 
from that list.  Orbit will list all possible exposure counter parties (see page 15).  Check-mark lines to indicate that the 
Accounting Entity has an exposure relationship to the counter party/currency 
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Setup Exposure Relationships 

•  When an “Accounting Entity” is selected, Orbit lists it’s exposure counter parties first, followed by all other potential 
counter parties 

•  Existing exposure counter parties are identified by the check-mark in the first column (see red circle) 
•  To add new exposures, simply click on the check-box of one of the lines that is not checked 
•  If the exposure is NOT associated with another Entity ( the exposure relationship is NOT an inter-company relationship), 

select one of the the “External” entity lines and click the “Add Currency” button that appears at the bottom of the window 
•  Orbit will prompt you to enter the code for the new currency 
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Setup Exposure Relationships 

•  If the exposure is NOT associated with another Entity ( the exposure relationship is NOT an inter-company relationship), 
select one of the the “External” entity lines and click the “Add Currency” button that appears at the bottom of the window 

•  Orbit will prompt you to enter the code for the new currency 

16 

Click to add 
a new 
External 
Currency 
exposure 



Setup Exposure Relationships 

•  Click on a check-box so that the line is check-marked.  This action creates a new exposure relationship.  In the example 
above we would be creating an exposure relationship named:  “Corporate -> GBP (Bio-Metrics Prop)” 

•  To delete a relationship, uncheck the checkbox of the exposure.  If exposure entry forms already exist for the 
relationship, Orbit won’t let you delete it.  Instead, you will need to uncheck the “Active” checkbox.  This will tell Orbit not 
to include the relationship in future processing 
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Setup Exposure Relationships 

•  If you are including custom properties in your hedge trades,  you will need to code those properties for each exposure 
relationship 

•   Click the disclosure control to reveal “Optional Properties” (red circle) 
•  Click the “Edit Custom Properties” button to popup the properties entry form.  Provide the required values and press the 

“Done” button 
•  If the “Auto Save” check-box is set, your custom property changes are save automatically.  Otherwise click the “Save” 

button (hidden beneath the custom properties dialog in this screenshot) 
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Setup Exposure Relationships 

•  You can customize the lines that appear on the forecast entry form for a specific exposure relationship 
•  Select the exposure line for the relationship you wish to customize 
•  Click on the “Include/Exclude Worksheet Lines” button.  Orbit pops up the “Forecast Worksheet Lines” editor 
•  To include/exclude a row from the worksheet for “LE114-Geoline USD -> EUR (External)”, locate the row and check/

uncheck the checkbox in the “Incld?” column 
•  When you are done be sure to click the “Save Worksheet Lines…” button 
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Orbit Administration and Setup 

Approve Exposure Relationships Requested by Remote Users  
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Approve Exposure Relationships Requested by Remote Users  

•  Non-Treasury, remote users, using OrbitHF or the Orbit Web Portal, may initiate the setup of new Exposure Relationships 
•  Treasury gives access to this feature on the “Setup” tab of the “FX – I/C Balance Sheet Hedge Worksheet” 

•  The new exposure relationship  is not available for use until Treasury reviews and approves it by marking it as “Active”.  
Exposure Forecast Entry forms are not published for new exposure relationships unless they are “Active”.  If a new 
relationship is created and is required for the current period, you can manually create the form 

•  When a new relationship is requested from the field, notification will be posted on the Orbit message board and email 
notification may be sent (depending on the setup shown above) 
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User Initiated, Inter-Company Relationship Notification 

•  When a new exposure relationship is created by field operators, Orbit posts a notification to the message board in the 
Orbit Client application 

•  When Treasury sees this notice they double-click it.  Orbit takes them to the inter-company exposure relationship screen 
(shown on the next slide ) 

•  In addition to the message board notice, Orbit can generate an email to Treasury staff alerting them to the new 
exposure 
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Treasury Completes Inter-Company Relationship Setup 

•  Before a new exposure can be used, Treasury must complete the setup process.  This involves coding of custom 
properties and customizing the data entry lines that will appear on the worksheet when it is published 

•  To code custom properties, click on the disclosure control (red bubble).  This will reveal additional controls.  Click on the 
“Edit Custom Properties” button.  After your edits be sure and press the SAVE button (not shown on this slide, it’s one of 
the “Optional Properties” controls 

•  Click on the “Include/Exclude Worksheet Lines” button to  customize the forecast entry rows that will appear on the 
worksheet 
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Orbit Administration and Setup 

Setup of Orbit OrbitHF and Web Portal users 
and Assign Exposure Forecast Entry Forms  
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Setup of OrbitHF/Orbit Web Portal users 

•  Once exposure relationships are defined, the next step is to assign data-entry responsibility for those relationships to 
remote users 

•  Remote users will access Exposure Forecast Data Entry forms through either the OrbitHF application or via the Orbit 
Web Portal 

•  The first step in assigning forms to remote users is to setup the person/persons as OrbitHF and/or Orbit Web Portal 
Users 

•  From the “Main Menu Window”, go to the “Environment” tab 
•  Click the “Web Services Admin” button 
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Setup of OrbitHF/Orbit Web Portal users 

•  To create a new Web Portal User, click the “New” button (red circle) 
•  A new line is added to the Web Users list with the detail fields expanded and displayed below the main line 
•  Fill in the required values.  The new user will log into the Orbit Web Portal using his/her email address 
•  Set the password to a default ( “orbit” ).  The user will be forced to change his/her password the first time they log in 
•  Press the “Save” button to save the new user 

•  Once the remote user is set up, you may assign access to Exposure Forecast Entry forms as shown on the next page 
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Assign Forecast Data Entry Forms to OrbitHF/Orbit Web 
Portal users 

•  Return to the “Setup Balance Sheet Forecast Worksheet” window 
•  Main Menu Window -> FX (tab) -> “Enter Balance Sheet Forecast” (button) 
•  Go to the “Worksheet Assignment” tab 
•  Select the Web Portal User from the list on the left 
•  From the list on the right, select the exposure relationships the user will be responsible for 
•  Click the “<<“ button to move those forms to the “Assigned Forms” list 
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Assign Forecast Data Entry Forms to OrbitHF/Orbit Web 
Portal users 

•  Click the “Save” button to save the assignment 
•  NOTE: 

–  A form may be assigned to one  or more users 
–  A user may  be responsible for one or more forms 
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Publication of Exposure Forecast Data Entry Forms  
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Publication of Exposure Forecast Data Entry Forms  

•  Treasury publishes Exposure Forecast Data Entry Forms each month 
•  Forecast Forms are typically published near the beginning of the month with the aim of forecasting the expected inter-

company balance for the end of the month 

•  From the “Main Menu Window”, go to the “FX” tab 
•  Click the “Enter Balance Sheet Forecast” button 
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Publication of Exposure Forecast Data Entry Forms  

•  Select the Fiscal Period for which you will be publishing forms (red circle) 
•  Click the “Create ALL Worksheets for Period” button 

–  Orbit will cycle through all accounting entities listed on the left.  You will see this happening.  As each Accounting 
Entity is selected, it’s exposure counter parties will be listed in the middle columns of the window.  At this point 
Orbit is gathering information about forms that are available for publication 

–  Orbit will tell you how many forms it is ready to publish and ask if you want to proceed 
–  Answer “Continue” and Orbit will publish the forms 
–  To delete the publication, click on the “Delete ALL Worksheets for Period” button 
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Publication of Exposure Data Entry Forms Each Month  

•  Click on a single Accounting Entity 
•  Orbit lists the worksheets/exposures associated with that Accounting Entity 
•  The current status of the worksheet is listed under the “Worksheet Status” column heading 
•  To operate on a single worksheet, select it and use the buttons on the right 
•  To view or edit values entered into a worksheet, double-click or click the “View/Edit Worksheet for Period” button 
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Notification to Web Portal Users that Forms are Ready for 
Input  
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Notification to Web Portal Users that Forms are Ready for 
Input  

•  After publishing forms, Treasury may use Orbit to send email notification to OrbitHF/Web Portal Users 
•  Go to the “Setup Balance Sheet Forecast Worksheet” window 
•  Main Menu Window -> FX (tab) -> “Enter Balance Sheet Forecast” (button) 
•  Go to the “Publication” tab 
•  Click the “Notify Users: Forms are Ready” button 

34 



Notification to Web Portal Users that Forms are Ready for 
Input  

•  Orbit will send email to everyone listed where these  is a check-mark next to their name 
•  The list includes one line for each user/form 
•  If a user has multiple forms, s/he will receive a single email listing all of his/her forms 
•  The subject and message body will be the same for all notifications sent.  The symbol text [FP] included in subject line 

and message body will be translated into the current forecast period ( for example: FP2014 Q4 DEC) 
•  To send the messages, click the “Send Messages” button (red circle) 

35 



View/Edit Exposure Forecast Data Entry Forms 
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View/Edit Exposure Forecast Data Entry Forms 

•  Treasury may view/edit published Exposure Forecast Data Entry Forms 
•  Go to the “Setup Balance Sheet Forecast Worksheet” window 
•  Main Menu Window -> FX (tab) -> “Enter Balance Sheet Forecast” (button) 
•  Go to the “Publication” tab 
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View/Edit Exposure Forecast Data Entry Forms 

•  Select the Fiscal Period (note: the current forecast period will be set automatically) 
•  Select an Accounting Entity.  The Accounting Entity’s exposures are listed on the right 
•  The status for each exposure/forecast form appears in the “Worksheet Status” column (circled red) 
•  If the form is checked out for update, there will be a check-mark in the “CKOT” column 
•  To view/edit the form, double-click the line or select the line and click the “View/Edit Worksheet For Period” button 
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View/Edit Exposure Forecast Data Entry Forms 

•  Click into cells and enter forecast data according to instructions 
•  Instructions for each column may be viewed by clicking on the blue, underlined column headings (see the top-right 

bubble) 
•  Multiple detail lines may be entered for any cell value.  Click into the cell and click the “Edit Cell Detail” button to pop up 

a list data entry dialog.  The total value of the detail will appear in the cell. but the detail is saved and may be viewed 
later by again clicking the “Edit Cell Detail” button 

•  When you are done with data entry REMEMBER TO PRESS THE SAVE button 
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View/Edit Exposure Forecast Data Entry Forms 

•  When you are done with data entry REMEMBER TO PRESS THE SAVE button 
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Lock Exposure Forecast Columns to Prevent Further Entry 
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Lock Exposure Forecast Columns to Prevent Further Entry 

•  Treasury may lock individual columns to prevent further data entry in Exposure Forecast Data Entry forms 
•  Your forms may be designed to receive forecast updates to different columns during specific time periods during the 

month 
•  In those cases, you may want to lock columns after certain dates to prevent further entry 
•  Go to the “Setup Balance Sheet Forecast Worksheet” window 
•  Main Menu Window -> FX (tab) -> “Enter Balance Sheet Forecast” (button) 
•  Go to the “Publication” tab 
•  An Accounting Entity and one or it’s exposures 
•  Double-click to open the form for view/edit 
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Lock Exposure Forecast Columns to Prevent Further Entry 

•  Click on the disclosure control circled in red 
•  This will cause hidden controls to be revealed 
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Lock Exposure Forecast Columns to Prevent Further Entry 

•  Click the “Apply Locks to ALL” check-box 
•  When this box is checked, Orbit will perform lock/unlock actions to all worksheets in the period 
•  Click on one or more of the “Lock Column” check-boxes to lock or unlock the column 
•  Note:  When “Apply Locks to ALL” is in effect,  the lock/unlock actions will be performed immediately.  You do not need 

to save the form for the action to occur.  If “Apply Locks to ALL” is not checked, Lock Column actions apply only to the 
current form and the  form must be saved before the lock/unlock takes effect 
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Create Mid-month and Month-End  
Payment Requests Using the OrbitHF Application 
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Enter Payment Requests Using the OrbitHF Application 

•  Remote users use the OrbitHF application to make Mid-Month and Month-End payment requests 
•  There is a separate document that describes OrbitHF installation and use.  The next several pages in this document 

describe the process of making payment requests 
•  After we show how payment requests are made, the next section describes how Treasury handles those requests 
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Mid-Month and Month-End Payments 

•  To make trade payments to counter parties that are part of the Inter-Company Balance Sheet Hedge program,   use the 
“Payment Notification/Request” tab of the OrbitHF application,  

•  If payment will be made by wire,  actions here will notify Orbit of the payment, but the remote user will make the 
payment him/herself 

•  Select a Payor and Payee.  Complete the form ( enter Pay Amount, Value Date ) and press the Submit button 
•  NOTES:   

–  The Payor and Payee selections available to you on this window depend on Inter-Company relationships that are 
setup in Orbit 

–  If you need to make a payment and are unable to select the parties here, use the “Request Setup of New IC 
Relationship” tab (not documented here) 47 
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Mid-Month and Month-End Payments 
•  NOTES (continued):   

–  An IC Relationship consists of the Accounting Entity (the entity that holds the exposure) and an Exposure entity 
(the entity that creates the exposure for the Accounting Entity). 

–  An Accounting Entity has an exposure with the Exposure Entity BECAUSE the Accounting Entity has a 
Payable(liability)  or Receivable (asset) balance with the Exposure Entity AND that asset or liability is 
denominated in a currency that is different from the accounting currency of the Accounting Entity 

–  In the example on the previous slide, the IC relationship in Orbit is “France SAS -> Israel” where France is the 
accounting entity and Israel is the exposure entity 

–  France a 4.5 million ILS receivable balance with Israel.  Since France is EUR functional, this receivable balance 
represents an exposure to ILS 

–  In the example, a user in Israel has identified Israel as the Payor.  A receivable in France is a Payable in Israel, 
consequently it would be Israel initiating the payment to France.  France is selected as the Payee (beneficiary).  
Orbit looks up the current forecast form and presents the receivable balance it finds there as the payable 
obligation for Israel 

–  Orbit knows that the exposure amount is denominated in ILS and makes the “Pay Amount” field editable.  This 
allows Israel to enter the ILS amount as the Payment Amount.  Orbit will compute the estimated EUR amount 
France will receive based on the accounting rate closest to the Value Date that is entered 

–  In the example, Israel elects to pay France 4 million ILS.  France will receive approximately 851k EUR.  The 
actual EUR amount France receives will depend on the final rate achieved on the FX spot trade that will be 
created as a consequence of submitting the request 

–  When the request is submitted, it’s status is set to NEW.  The request will be made visible to Treasury.  Treasury 
will review the request and, if approved, schedule the trade(s) for execution 

–  When approved by Treasury 3 things happen: 
1.  A Spot trade (in the name of Israel) is created to SELL ILS (4.5m)  and BUY EUR 
2.  A Forward trade (in the name of France) is created to adjust Treasury’s hedge position:  BUY ILS, SELL 

EUR  to next periods hedge settlement date.  (France’s original hedge for the ILS receivable would have 
been to SELL ILS/BUY EUR to the hedge settlement date) 

3.  The “France -> Israel” forecast worksheet will be updated to reduce the receivable by 4m  
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Mid-Month and Month-End Payments 

•  This is an example where France SAS is selected as the payor for the IC Relationship “France SAS -> Israel” 
•  In this case France needs to deliver ILS to Israel to cover France’s payable to Israel 
•  France pays EUR to buy ILS.  The ILS amount is the known amount, so the form makes the “Receive Amount” editable 

and will compute the estimated EUR cost 
•  Type the ILS amount due (the payment amount) which is the “known” amount into the green “Receive Amount” field 
•  Orbit estimates EUR amount that France SAS will pay to buy ILS ( 21,296.85 EUR) 
•  When the spot trade is created, it will be created with the trading entity being France to BUY ILS (100k) and SELL EUR 
•  Press the SUBMIT button to complete the request (circled red) 
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Treasury Handling of Payment Requests 
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Treasury Handling of Payment Requests 

•  Remote users use the OrbitHF application to make Mid-Month and Month-End payment requests 
•  Treasury handles those requests on the “FX – I/C Balance Sheet Hedge Worksheet” 
•  Main Menu Window -> FX (tab) -> Balance Sheet Trade Worksheet 
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Treasury Handling of Payment Requests 

•  Select the Hedge Period (Orbit will default selection to the current Hedge Period – which will be the most recently 
published period 

•  Click the “Get Requirements” button or go directly to the “Apply Payments” tab 
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Payment Completion by Treasury 

•  Payment requests are listed for a range of dates and may be filtered by currency and status(New, Pending etc…).  Click 
the “Refresh” button to refresh the payment requests list 

•  Treasury selects a payment and completes the area on the right under (red rectangle) 
•  The status is set to Approved and the payment request is “Submitted” 
•  When an approved payment is submitted, Orbit creates required trade intentions which will be forwarded to the trading 

portal for execution 
•  Orbit will create “spot” (near) and forward (far) trades automatically unless the “No Near Trade” or “No Far Trade” check-

boxes are set.  Both trades will use the “Trade Date” value set by Treasury.  Spot (near) trades mature on the Value 
Date.  Forward trades will mature on the hedge period settlement date ( 9/30/2014 in this example ) 

•  Orbit updates appropriate rows in forecast entry worksheets that are impacted by the payment 53 
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Payment Completion by Treasury 

•  The “Event Type” is equivalent to the Orbit trade purpose.  Orbit sets this based on the 
request/value date and the defaults defined on the “Setup” tab of the same window where 
“Apply Payments” lives  
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Payment Completion by Treasury 

•  If your trade operations use “custom properties”, the payment will have inherited it’s custom properties from the “trading 
entity” of the inter-company relationship where the payment occurred 

55 



Payment Completion by Treasury 

•  This shows the results of a payment by France SAS to Israel of 100k ILS.  France buys ILS and pays EUR.  The ILS is 
delivered to Israel 

•  When payment requests are APPROVED, Orbit creates a spot deal to make the payment 
•  From Orbit’s point of view,  the IC Exposure Relationship,  Accounting Entity is always the Trading Entity 
•  To make the payment, France buys ILS and pays EUR 
•  The second trade (trade 205) is the forward that adjusts the hedge position between France and Israel 
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Payment Completion by Treasury 

•  When the payment request is APPROVED, the payment amount is added to the forecast worksheet as shown above 
(red rectangle) 

•  This has the effect of reducing the payables exposure (which are normally entered as negative numbers) 
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The IC Balance Sheet Trade Worksheet 
Use Orbit to View and Hedge Consolidated Exposures  
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Use Orbit to View and Hedge Consolidated Exposures  

•  The next 30+ pages discuss using the orbit FX I/C Balance Sheet Hedge Worksheet 
•  We first spend a few pages covering the mechanics of the worksheet.  We then provide a simplified example of a 

complete Hedging cycle 
•  It is on the Balance Sheet Trading Worksheet, where everything we have covered previously comes together 
•  To get to the Trading Worksheet:   

–  Main Menu Window -> FX (tab) -> Balance Sheet Trade Worksheet (button) 
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Use Orbit to View and Hedge Consolidated Exposures  

•  Select the Hedge Period by clicking on the “Set hedge period” button.  By default, Orbit will set this value to the current 
Hedge period.  The current period is the period that was most recently published (see page 30) 

•  The dates that appear (circled in red) are set based on the Hedge Period selection and a table of dates that is 
maintained by Treasury on the “Setup” tab.  If you select a Hedge Period and Orbit complains about missing dates, go 
to the “Setup” tab, click into the last “Settle Date” cell (03/31/2014) and press return.  Orbit will move you to the 
“Forward Date” cell for FY2015 Q1 MAR.  Enter the planned forward date and press enter.  Orbit computes a trade date 
for the Forward Date, puts it into the FY2015 Q2 APR “Trade Date” cell and moves to that.   Continue adding dates and 
then press the Save button  
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Use Orbit to View and Hedge Consolidated Exposures  

•  The hedge position displayed by the Worksheet is based on what “today” is.  “Today” for the worksheet is whatever date 
is entered in the “Today” field (red circle) 

•  If you press the “trade” button located just above the “Today” field, Orbit will set today equal to the worksheet  “Trade 
Date”  (12/29/2014) in this case 

•  Press the “Get Requirements” button to load and display the hedge position 
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Use Orbit to View and Hedge Consolidated Exposures  

•  Use the drop-down menu circled in red to change the values that appear in the Accounting Entity column 
•  Each un-expanded line on the worksheet shows the position for a Currency and Accounting Entity  
•  Expand a worksheet line by clicking the small triangle (appears as a + sign in MS Windows).  When expanded, Orbit 

displays all of the Forecast Entry Forms that are rolled up into the Currency/Accounting Entity line 
•  If you select one of the Forecast Entry Form lines, the “View Worksheet” button becomes enabled.  Click this button to 

view the Forecast Entry Form for the selected item 
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Use Orbit to View and Hedge Consolidated Exposures  

•  When “Use Trading Portal by Default” is checked (red circle),  Orbit will set the Trade Method of any trades created by 
the worksheet to “Portal” 

•  Use the currency drop-down menu to limit displayed positions to a single currency or “ALL” currencies 
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Use Orbit to View and Hedge Consolidated Exposures  
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Use Orbit to View and Hedge Consolidated Exposures  
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Use Orbit to View and Hedge Consolidated Exposures  
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•  Go to the “Trades List” tab to view trades that are part of the position 
•  Double-click on a trade line to view it’s details (Orbit will move you to the “Trade Entry” tab to view trade detail) 
•  The “Export” and “Print” buttons operate on trades shown in the “Trades List”.  Export will export these columns:    

Entity, TradeID, Bank, TradeType ,  Buy/Sell ,  Currency ,  Contract Amt ,  Base Currency ,  Base Amt ,  Spot Rate ,  
Points ,  Contract Rate ,  Trade Date ,  Mat/Expiry Date ,  Value Date ,  Status ,  Purpose ,  Comments ,  Prem Date ,  
Prem Cur ,  Prem Pct ,  Prem Amt 

•  Click the “Get Worksheet Trades For Period” button to have Orbit run a query that will bring in all trades that impact the 
current period 

•  Use the “Go to Custom Export” button to open the “FX Trade Entry Window”.  Use the “Export” tab on that window to 
export trade details in custom formats 
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Use Orbit to View and Hedge Consolidated Exposures  
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•  To view and/or edit the details of a trade, select the trade and click the “Trade Entry” tab or double-click the trade line 
and Orbit will automatically go to the “Trade Entry” tab 



Use Orbit to View and Hedge Consolidated Exposures  
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•  The selected trade is listed in the “Trades” list on the left side of the “Trade Entry” panel.  In this case the trade is part of 
a SWAP, so its companion is also listed 

•  The details of the trade are listed in the middle with additional detail and controls listed on the right side of the panel 
•  Note that if either the contract or base currencies are NDF currencies,  the “NDF Trade” check-box appears with the 

“Fixing Date” showing to the right of the check-box 
•  In this example, the trade has been “Executed” and Orbit will not allow edits to the details of the trade.  You can un-

check the “Executed” check-box to change the status of the Trade to “Approved” and edits would be allowed 
•  If this trade had been “Confirmed” Orbit would not allow any edits to the details of the trade.  To un-confirm a confirmed 

trade you would need to go to: Main Menu Window -> FX (tab) -> Trade Confirmation (button) 
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Use Orbit to View and Hedge Consolidated Exposures  
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•  With the “Executed” check-box unchecked, trade details become editable 
•  When a trade is created where either the contract or base currencies are “NDF” currencies, Orbit will automatically 

compute a fixing date that will be 2 (1 day for RUB)  workdays prior to the contract maturity date.  It is the combination 
of NDF currency AND the presence of a FIXING date that makes the trade an NDF Trade 

•  If you need to tell Orbit that, in fact, this particular trade is deliverable, un-check the “NDF Trade” checkbox.  Orbit will 
set the Fixing Date to blanks and the trade will no longer be considered an “NDF Trade” 

•  Orbit does not consider holidays when computing the Fixing Date.  You can change the Fixing Date by typing in a new 
date and pressing the “Save” button.  If you are trading through a portal, the portal (FXAll or 360T) will return the correct 
fixing date when execution details are retrieved  
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Use Orbit to View and Hedge Consolidated Exposures  
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•  Back on the “Trades List” tab, use the “Go to Custom Export” button to open the “FX Trade Entry Window”.  Use the 
“Export” tab on that window to export trade details in custom formats 
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Custom Export on the FX Trade Entry Window 
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•  Us the “List” tab on the “FX Trade Entry” window to query trades you want to export 

Query trades to export 
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“Export” tab 



Custom Export on the FX Trade Entry Window 
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•  Select the export template you will use for the export 
•  Click the check-box next to each trade you want to export 
•  You may select multiple trades and then set the check-box state for the entire selection by clicking the check-box at the 

bottom of the list 
•  Use the “Browse” button to select a destination folder for the export.  You can save your export destination selection 

and associate it with the export template by clicking the “Save Location For Template” button 
•  Enter a file name for the export and click the “Finish Export” button to complete the export 
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Custom Export on the FX Trade Entry Window 
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•  The format of data in the export is controlled by the “Export Template” 
•  Export Templates are created and maintained on the “Export Setup” tab 
•  You would normally work with Orbit support to create templates 



Hedge Cycle Example 

The next 20+ pages presents a simplified example of a 
complete hedge cycle using the FX I/C Balance Sheet 

Hedge Worksheet 
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•  Our starting point is the August Hedge Period where we set the forecast that drives the September ( 9/30 ) hedge 
•  The August Forecast Data Entry Form is published early in August and collects actual July month-end IC Balance 

(column 1), August known and forecast activity (columns 2 and 3)  and forecasts a September end-of-month IC balance 
(column 4) 

•  The IC Exposure Relationship is described as “France SAS has exposure to ILS through Israel – Mfg” 
•  The August exposure forecast entry form has been entered with a 5m ILS net exposure.  This amount is a forecast of 

what we expect the September end-of-month IC balance to be 
•  This exposure was hedged in late August and matures the end of September (9/30) 

This sets the stage for discussion that begins on the next page on the “FX I/C Balance Sheet Hedge Worksheet” 
Main Menu Window -> FX (tab) -> Balance Sheet Trade Worksheet (button) 
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•  The Hedge Period is set to “FY2014 Q3 August” 
•  The IC Balance we are hedging is the forecast balance at the end of September.  We call the “Hedge Period” August 

because that is when the forecast is developed and when the hedge is put on out to the end of September  
•  The worksheet “today” value is set to 8/27.  Note: this is the standard August Hedge Period trade Date (defined on the 

“Setup” tab).  This is the date we trade the hedge to cover our forecasted September 30 IC Balance 
•  There is no Near trade since this is the first month we are using the worksheet.  Normally the Near trade would be a 

spot deal settling on 8/29 
•  The Far trade is the forward hedge going out to 9/30 

•  On the worksheet, we complete the hedge by clicking the “Far” checkbox 
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•  Now “today” is 9/10.  We have moved into September 
•  The “Hedge Period” is set to September.  In this period, we forecast the expected IC Balance to the end of October 
•  The September forecast forms have been published.  Staff responsible for data entry into those forms have entered the 

August end-of-month (8/31) actual IC Balances as reported in the GL.  Where possible, Orbit will set the actual balances 
automatically from GL feeds 

•  “Get Requirements” shows that our forecast end of October IC Balance is 6,150,000 and our current outstanding hedges 
(the hedge from last month) is -5,000,000 

•  Orbit proposes trade amounts in the Near and Far trade columns.  We will not be trading these values until 9/26 
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•  Select “Re-Hedge” in the “Display” button group (upper left red circle) 
•  Orbit refreshes the worksheet to show the “Re-Hedge” view.  “Today” is 9/10.  Orbit sets the “Trade Date” to today for Re-

Hedge actions.  If you want to trade Re-Hedge on a different date, type that date into the “Trade Date” field.  WARNING -  if 
you switch back to “Forecast” view, the “Trade Date” will be reset to the default hedge period trade date (9/26 in this 
example) 

•  The August ending balance actuals have already been entered into the September forecast worksheet 
•  The “Exposure Long/(Short)” cell computes the difference between the August forecast and actual balances. Orbit will 

provide a summary when you click on the “Exposure Long/(Short)” cell 
•  The summary shows the actual balance for August as 4,650,000 for vs. a forecast of 5,000,000.  The forecast balance 

comes from the prior period (August) IC Balance forecast 
•  The difference between the 2 amounts is -350,000.  We originally hedged our forecast balance but find that our actual 

balance was 350k lower.  This means that we are over-hedged out to 9/30 
•  The Near trade column has been repurposed and renamed to “Exp In USD Equiv”.  This value is the USD equivalent of the 

over-hedge 
•  Orbit proposes a “Hedge Adjustment” trade in the Far trade column  
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•  Clicking the “Far” checkbox causes Orbit to generate a hedge adjustment trade 
•  The trade date for that trade will be the value that appears in the “Trade Date” field.  When you switch to “Re-Hedge” view, 

Orbit automatically sets the “Trade Date” to whatever value is found in the “Today” field.  If you want to trade on a different 
date, be sure and type the desired date into the “Trade Date” field 

•  The hedge adjustment trade will have a maturity date equal to the hedge period “Settle Date” ( 9/30 ) 
•  When the trade is created, it is marked as a “Test” trade.  In our example, the “Include Test Trades in Outstanding Hedge” 

checkbox is set, so Orbit will include the impact of TEST trades in both “Outstanding Hedges” and “Position Today” 
columns 

•  You can double-click on the “Hedge Adjustment” amount and Orbit will jump to the “Trades List” tab and show you the trade 
that was created  

79 



•  The hedge adjustment trade Buys ILS Forward to 9/30. This will have the effect of reducing the existing 9/30 hedge 
position 
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•  If you switch back to “Forecast” view, Orbit redisplays the view reflecting the September forecast 
•  Note:  the trade date has been switched back to the default hedge period trade date 
•  The “Outstanding Hedges” column reflects the hedge adjustment (again note the adjustment trade is included even as a 

TEST trade because the “Incld Test Trades in Outstanding Hdgs” checkbox is set) 
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•  On the September forecast data entry form, France SAS includes a 4.5 million ILS receivable in their exposure balance 
•  On the next slides we show what happens when Israel acts to make a payment on that receivable 
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•  Today has now moved to 9/15.  Staff responsible for the “France SAS -> Israel” relationship used OrbitHF to request that a 
payment be made to settle the France SAS receivable 

•  Treasury sees the payment request on the “Apply Payments” tab 
•  The payment is selected and reviewed 
•  Treasury  “Approves” the payment (change status to Approved) by clicking on the “Approved” checkbox 
•  Clicking the checkbox initiates the action.  Orbit creates a SWAP to 1) make the payment and 2) adjust the August hedge 

that settles on 9/30 
•  Orbit will update the September forecast data entry form to show the impact of the payment 
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•  Go to the “Trades List” tab to see the new trades added to the list of trades impacting the current hedge period 
•  Trade 83 is the spot trade to sell ILS and pay EUR.  This is the trade that implements the payment.  The bank that performs 

the trade will be instructed to deliver EUR to France SAS.  Israel will be instructed by Treasury to deliver 4 million ILS to the 
bank 

•  Trade 84  adjusts the outstanding hedge from August that will mature 9/30 
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•  Today is now 9/18 
•  The Forecast view shows the impact of the payment hedge adjustment trade 
•  The “Exposure Long/(Short)” column reflects the payment, which has been automatically posted to the forecast by Orbit 
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•  Go to the “Trades List” tab and click the “List Mid-Month Trades” button 
•  Orbit lists all Mid-Month trades 
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•  Today now moves to 9/20 
•  Visit the “Apply Payments” tab and look at the “MONTHEND” payment request.  Israel plans to pay 500k ILS on Israel’s 

receivable balance with France SAS.  They have requested this payment occur on 9/30 
•  This is an ILS denominated receivable on France’s books.  Israel will actually be paying them the EUR equivalent of 500k ILS 
•  The request is marked as APPROVED and submitted 
•  Orbit treats this specially, because the Event Type is “MONTHEND” and the Value Date is 9/30 (the August Hedge Period 

settlement date) 
•  Rather than creating a trade, Orbit will reduce the amount of the compensating, “Near” trade that closes out August Hedge 

Period maturing trades.  The August hedge,  put on by France SAS,  was to SELL ILS forward to 9/30.  At maturity France will 
need to deliver ILS to the bank. With the MONTHEND payment request, Orbit will instruct Israel to pay 500K ILS to the counter 
party bank.  This allows Orbit to reduce the compensating trade requirement where we buy ILS spot to cover the maturing 9/30 
August hedge.  France receives their payment from Israel in the form of a reduced requirement to pay EUR on the close-out 
trade 
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•  Today now moves to 9/26 – the end of September.  We call this the September Hedge Period because forecast data entry and 
trading occur in September.  But remember that the balance we are forecasting is the October ending I/C balance.  The hedge 
we put on at the end of September is to cover the forecasted 10/31 balance 

•  On 9/26 we to close out the August 9/30 hedge and put on the new September Period Hedge (which hedges the forecast 
October ending I/C balance) 

•  When we click on the “Outstanding Hedges” cell, Orbit provides an explanation for the amount.  We see that “outstanding 
hedges” includes a credit for the 500k ILS that Israel will pay at month-end to the counter-party bank 

•  We also see the “Near Trade” amount reflects this adjustment 
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•  The hedge day for SEPTEMBER is 9/26 
•  After review, we create both the “Near” and “Far” trade intentions by clicking on the Near and Far checkboxes 
•  The Near (spot) trade closed out what remained of the maturing August 9/30 hedge 
•  The Far (forward to 10/31) trade, hedges our forecast October ending I/C balance 

•  The “Outstanding Hedges” column reflects the new forward out to 10/31 

•  After preparing trade intentions, Treasury would use the FX Trade Portal interface to upload trades to their trading portal for 
execution 

•  After trade execution, execution results are downloaded from the Portal back into Orbit.  Orbit changes the status of trades 
from “Approved” to “Executed” (and possibly confirmed depending on how you have configured Orbit) 

•  The hedge cycle for September is complete and will begin anew for October 
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